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Banish Boring Bullet Points 
A few years ago, data display maven and Yale 
Professor Edward Tufte caused a minor stir 
when he called PowerPoint “evil” and sniped 
that “Power corrupts.  PowerPoint corrupts 
absolutely.”  [Wired, Issue 11.09, September 
2003].  Regrettably, Tufte, like so many others, 
only knows PowerPoint at its most banal; but, 
judging presentation software by bad 
PowerPoints is like judging all women by Paris Hilton.   Truth is, even Microsoft doesn’t 
know how to use PowerPoint to its best advantage.  Where do they get those awful 
templates and wizards? 
 
You can perform amazing feats and be a more effective advocate using presentation 
software; but, you’ve got to set aside nearly all you know about PowerPoint and the 
ways you’ve seen it used.  Cast out PowerPoint the Huckster and embrace PowerPoint 
the Persuader! 
 
Start Simple…and Grow 
It's a mistake to wait until the eve of mediation or trial to start building a presentation.  
Instead, use PowerPoint throughout the case—as you interview witnesses, work with 
experts, and conduct discovery. Forget slide templates.   Begin your presentation with a 
white background and black type, or vice versa. Start inserting your visual evidence, 
photos, video, deposition excerpts, maps, graphs, key documents, jury issues, and so 
forth, each on a single slide. 
 
Don’t worry about appearance or order at first—and certainly waste no time on bells and 
whistles like animated titling or sound effects. Simply load every visual you might use 
into the presentation, resizing the images for effective viewing. At this stage, the 
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program is just a vessel to hold your visual anchors. As you gather new visuals, insert 
them into the presentation. Don't forget audio evidence, too. Voice mail, recorded 
statements, and 911 calls can all be dropped into PowerPoint. 
 
Once your visual evidence and demonstrative exhibits are in PowerPoint, you can easily 
access them. Though PowerPoint is a linear presentation tool, it also provides direct 
access to any slide (type the slide number, then hit "Enter") and can hyperlink from any 
object in any slide to any other slide, file, or external application. As the case develops, 
you'll return frequently to your presentation—to show a photo to a witness, a medical 
illustration to a doctor, or a deposition video clip to the court during a motion hearing.  
Along the way, you'll add titles, labels, highlighting, and animation, as well as determine 
slide order, keeping what works and dropping what doesn't. The presentation evolves 
with the case, and a polished product emerges gradually as your skill level grows. 
 
Animate to Instruct 
PowerPoint’s ability to animate text and "enhance" it with grating sound effects has long 
been abused.  “Cute” animated effects quickly become fingernails on a blackboard 
when repeated.  So, if you make it move, make it move for a reason lest you detract 
from your message. 
 
Animation done right and for a purpose is stunningly effective at increasing 
comprehension and focusing attention.  The enhanced animation capabilities added to 
PowerPoint in versions 2002 and 2003 offer better ways to bounce text on, off, and 
around the screen.   But, PowerPoint animation is capable of so much more when 
applied to “objects,” PowerPoint’s term for visual elements placed on a slide.  You can 
make objects fade in or out, change in size, or follow a precise motion path. But it’s the 
ability to animate multiple objects at the same time and tightly control their entrance, 
movements, and exit that puts the power in PowerPoint. You can even apply animation 
effects to the same object simultaneously, allowing, for example, an object to follow a 
defined path while also rotating and growing. 
 
You needn’t be a rocket scientist or run Pixar to build dynamic courtroom and mediation 
presentations.  With a little patient tinkering and creative thought, any PowerPoint user 
can turn out animations rivaling those once produced only by professionals. You can 
animate complex mechanical processes, reconstruct auto and air crashes, depict 
needed safety features in operation, or re-enact medical procedures. I've used 
PowerPoint to animate process flow leading to a petrochemical plant explosion, the 
operation of a computer's hard drive, and intersectional collisions. I’ve also used it to 
depict complex money trails in fraud cases and to bring an investigating officer's 
drawing of a wreck to life, making his hand-drawn cars collide as if the police report 
were enchanted.  
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To experiment with motion path animation, draw a 
rectangle on a blank slide representing a car. PowerPoint 
includes a toolbar of basic drawing tools (if you don't see it 
on-screen, choose the "View" menu and select "Toolbars," 
then "Drawing"). Right-click on the rectangle and choose 
"Custom Animation" from the pop-up menu. Select "Add 
Effect," then "Add Motion Paths," "Draw Custom Paths," 
and "Curve." 
 
Click on the center of your rectangle and drag a motion 
path for the object to follow, clicking at every point where 
you'd like your "car" to change direction. You may want to 
superimpose some rotation on the object to better mimic 
the real world. To do so, left-click on the rectangle and 
again select "Add Effect" from the "Custom Animation" 
menu, then "Emphasis" and "Spin." Menu options allow 
you to adjust the amount, speed, and direction of spin. You can instruct the spin to start 
with the motion path you've previously created (select "Start with Previous"). Now adjust 
the settings to achieve fluid movement. 
 
Once you know how to animate an object, you can layer multiple effects or animate 
several objects at once or according to a time line you control. This conceptual version 
of the wreck built with rectangles may suffice, but you might want to increase the 
sophistication of your image by, e.g., animating a top view of a vehicle against a 
background of an aerial photo of an accident scene.   
 
Movement lends itself to a host of events other than car wrecks.   Almost anything that 
changes over time, from flow charts to time lines to cash flows, is easier to grasp 
through animation, with the added advantage that when you control movement, you 
control where the jury looks and when. 
 
From client presentations to prepping witnesses to ADR proceedings, your animation 
efforts will pay off.  It rarely matters if lawyer-created animations are admissible 
because most cases never get to trial.  But even in court, if there is a competent 
sponsoring witness vouching for the fairness and accuracy of your depiction, most 
judges will admit it.  Head off objections by giving an advance copy of your presentation 
to opposing counsel.  If all else fails, you may get it admitted with an appropriate limiting 
instruction. 
 
Banish Bullet Points 
Titles and bullet points are not your message.  Your PowerPoint message flows from 
you as advocate and from your visual evidence.  Use bulleted text sparingly, as speaker 
notes or to orient your audience so they aren’t left wondering, “Which witness is he 
talking about?”   If a cause of action or contractual duty requires that five conditions be 
met, bulleting those five points makes sense.  Otherwise, keep bullet points to a 
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minimum, and where you can use something else, perhaps a document or photo, do it.  
Above all, respect your audience. The jury can read.  A presenter commits an 
unforgivable sin by reading slides aloud. 
 
Manage Focal Transitions: Moderator, Lecturer or Narrator?  
People can neither listen to two speakers at once nor read and listen at the same time.  
So, if the jurors are reading your slides, they aren’t hearing you.  Fortunately, most have 
no difficulty simultaneously watching and listening. 
 
As between you and the screen, where do you want the jury’s focus?  If you’re 
presenting a video deposition excerpt that needs to be seen and heard, you’re just the 
moderator and it’s important you remain silent and even avoid the jurors’ field of vision 
so as not to distract them.  Alternatively, when you’ve got something to say that 
demands the jurors’ focus, you don’t want their attention ping-ponging between screen 
and lecturer.  Instead, either insure that the visuals cease to draw attention or put your 
self into the visuals, such as by moving alongside the screen and gesturing.  Fading the 
screen to black is an unequivocal way to signal a shift in focus.  Make this transition 
clear and crisp—not jarring--so jurors know it’s time to look at you.   
 
In between these two poles, strive to narrate a screen filled with visually rich and 
engaging silent images and animations.  Hold the jurors’ ears but surrender their eyes 
to the screen.  Be their trusted instructor, presenting a documentary which equips them 
to reach the correct verdict.  Focal transitions are useful in controlling the rhythm of your 
presentation.   Used well, jurors stay awake and alert.  Used badly, jurors don’t know 
where to look and become frustrated and tired. 
 
Redemption 
At nearly all of the scores of speeches I give each year, someone asks, “What program 
did you use for your presentation?”  They’re amazed that it’s just PowerPoint.  Free of 
templates, unburdened by a mind-numbing succession of bullet points and brimming 
with strong visuals and purposeful animation, PowerPoint shines.  Professor Tufte got it 
wrong.  PowerPoint isn’t evil.  It’s just misunderstood. 
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Jurors better understand what they can 
see.  Putting key elements of your case 
into a visual presentation will help you 
organize your thinking and enhance 
your powers of persuasion 

 
Winning with PowerPoint 
 
 
Ever watched a trial on The Practice or Law and Order?  Of course, a real trial can't 
fairly be compared to those pumped-up spectacles, but dramatic and fast-moving trials 
on the tube foster high expectations in real life.  Trial lawyers can't meet all those 
media-stoked hopes, but there is one juror expectation we can fulfill: We can be 
interesting and prepared. 
 
To avoid a boring trial and help prepare your evidence, add structure and dash with 
presentation software.  Other industries have relied on Microsoft PowerPoint for years.  
The program is easy to learn and use, and it gives trial lawyers a simple, polished way 
to present information—jury charges, photographs, deposition excerpts, video clips, 
animations, graphs, and sounds.  Changes on the fly are a snap.  It's not the only 
presentation product, and perhaps not the best, but it's the standard by which all others 
are judged. 
 
You probably already own a copy of PowerPoint, because it came with your computer 
or as part of Microsoft Office.  Most users barely scratch the surface of PowerPoint's 
capabilities, and some err at the outset by using its banal templates to structure a 
presentation.  You can get the most from PowerPoint by forgetting the other 
presentations you've seen and using it—at first—as a simple way to organize, access, 
present, and enhance visual evidence. 
 
Suppose computers are not your strong point or you lack the time or interest to develop 
skills.  You may prefer to have someone else create your presentation.  Even if you 
don't build your own PowerPoint slides, you need to learn enough about how it's done to 
be able to make simple changes as needed.  Be sure you know the program well 
enough to reorder slides, blank the screen, add or remove text, save your changes, and 
restart the presentation should you need to reboot.  You need to be able to alter your 
demonstrative evidence in response to changing strategies and the court's rulings. 

 
Just constructing a PowerPoint presentation for trial or 
mediation hones your advocacy.  PowerPoint forces you 
to focus on a coherent, linear presentation, while helping 
you to define and identify case making points.  Best of all, 
using PowerPoint frees you from reliance on notes, so 
you're not chained to a lectern or leafing madly through a 
legal pad. 
 

The Internet was around for years before it leapt into the public consciousness, but 
hardly anyone paid attention until it acquired a new dimension: pictures.  We are wired 

PowerPoint forces you 
to focus on a coherent 
presentation, helps you 
define the key points of 
your case, and frees 
you from relying on 
notes. 
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for sight and programmed early for "show and tell," not just "tell." The most compelling 
stories end with the assertion, "I saw it with my own eyes." Our ability to retain 
information is 6.5 times better when we see and hear information, compared with only 
hearing it.  Visual persuasion is powerful, and technology makes it easy. 
 
Harnessing the power of visual persuasion and getting the most out of PowerPoint 
require that you ask at every step, "How do I depict that?" You also need to have a 
camera at the ready—a digital camera is easier, but a film camera and scanner will 
do—and you can't be shy about photographing case-related people, places, and things.  
In an injury case, for example, consider taking digital 
video or photographs of the scene, witnesses, injuries, 
vehicles, buildings, signs, debris, and even bumper 
stickers.  The last can reveal political affiliation, attitudes 
about drugs and drinking (a la “Don’t Follow Me, I’m 
High”) and even attitudes about safety.  Here’s a picture 
of an 18-wheeler proudly dubbed “Flirting with Disaster.”  
Imagine the value of such a photo if this truck’s driver 
had caused a fatal collision?   [Of course, some might 
properly question whether the idiot using the cell phone 
camera while driving at highway speeds was not the one 
truly flirting with disaster]. 
 
What you're seeking is a visual "anchor" for every idea you want the jury to accept and 
retain.  These images—like hieroglyphics or icons on a computer's desktop—serve as 
visual shorthand for testimonial and documentary evidence. 
 
Videotape every deposition, but if budgetary constraints make that impossible, don't 
leave without snapping a few photos of the deponent.  You can do more with video 
equipment.  Using low-cost video-conversion services or video-capture devices that 
cost $50 to $100, you can transfer images from VHS tapes to digital clips.  Then, you 
can drag-and-drop them into a PowerPoint presentation, edit them on your PC, and 
digitally project them from your computer.  If you, your staff, or your court-reporting 
service synchronize video time-codes to the deposition transcript, discrediting an 
opponent's witness can be almost as easy as highlighting an inconsistent statement and 
clicking "Play." 
 
Imaging technology has become powerful, accessible, and affordable.  Many digital 
cameras with megapixel definition cost less than $200 and provide direct-to-digital 
convenience.  Analog video cameras are inexpensive, and full-page color flatbed 
scanners cost as little as $50—enabling you to manipulate, enhance, and resize 
conventional photographs and documents using your computer.  Even devices that 
allow you to burn your own DVDs have slipped below $100.  DVDs, which offer content 
menus and hours of high-quality video, are becoming a great way to store and share 
graphics-rich PowerPoint presentations and digital video. 
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What You'll Need 
 
Hardware.  
Although Microsoft's recommendations are less demanding, I suggest running 
PowerPoint 2003 on a computer with a 1 gigahertz or faster processor, at least 512 
megabytes (MB) of memory (RAM), and 32 MB or more of dedicated video memory 
(VRAM).  This will ensure smooth playback of presentations, especially those including 
video and animation. 
 
For portability, choose a quality laptop over a desktop.  Toshiba, IBM, and Dell currently 
make good, reliable laptops.  Look for a model with a rewritable CD drive (CD-RW) or, 
better yet, a DVD recorder so you can burn larger PowerPoint presentations onto a disc.  
Laptops with a composite video (NTSC) output—a video signal that is compatible with a 
television’s (most computer signals aren't) can connect to the monitor of a conventional 
TV if a digital projector is unavailable. 
 
PowerPoint Software 
The latest version is still PowerPoint 2003, included in all versions of the Office XP 
software suite and also sold as a standalone application.  It is almost indistinguishable 
from PowerPoint 2002, so you don't need to upgrade unless you collaborate on 
presentations with other lawyers who also use the newer version or burn presentations 
on CDs.  An older version—PowerPoint 97 or 2000—may work, but upgrading is 
definitely worthwhile since the latest versions have more sophisticated animation tools 
that add real polish to your presentations. 
 
Presentation Tools 
There are several ways to display a PowerPoint presentation—ranging from a standard 
television screen to a laptop—but the best approach is to use a digital video projector 
and screen. 
 
Three years ago, it wasn't possible to get a small, bright, high-resolution projector for 
less than $3,500, a hefty sum for a device most trial lawyers will only use a few times a 
year.  But these projectors now cost as little as $800.  If you're not sure you will use the 
projector often enough to justify the investment, you can borrow or rent for awhile. 
 
If you decide to buy your own projector, it should support high-resolution graphics (at 
least XGA 1024 x 768 pixels) and image brightness of at least 1200 ANSI lumens.  Less 
bright units can be troublesome in courtrooms with lots of ambient light.  Keystone 
correction, which compensates for image distortion when the projector is used at an 
angle to the screen, will help offset awkward courtroom arrangements, and a remote 
control will let you roam the courtroom untethered. 
 
The lowest-tech part of the package can make a substantial difference in the success of 
your presentation.  Better-quality screens feature higher reflectivity, returning more of 
the projected image to the viewer's eye and making it appear brighter.  Courtrooms are 
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notoriously challenging places to set up a projection screen so that the jury, judge, 
opposing counsel, and court reporter can all see it well.  A projector and screen that 
support rear projection may be a useful solution.  Always visit the courtroom in advance, 
and ask the judge, bailiff, clerk or other court personnel about the court’s preferences.  
Setting up your screen and projector may entail a little creative choreography and the 
indulgence of the court. 
 
Since you are working with documents, you'll want to get the largest screen that will fit 
the dimensions and layout of the courtroom and the distance between projector and 
screen.  The Deluxe Insta-Theater screens from Da-Lite Corp.  (www.dalite.com) are a 
good choice for their easy setup and sturdy aluminum case.  Many courtrooms have a 
screen available, but be sure it's what you need and where you need it before leaving 
your screen at the office. 
 
Start Simply and Build 
It's a mistake to wait until the eve of trial to start building a presentation.  Instead, use it 
throughout the process—as you interview witnesses, work with experts, and conduct 
discovery.  Forget the templates and begin your presentation with just a white 
background and black type, or vice versa.  Start inserting your visual evidence--client 
photos, scene video, maps, graphs, scans of key documents, bullet points, jury issues, 
and so forth--each on a single screen (or "slide" in PowerPoint parlance).  I like to scan 
in the covers and relevant pages of the codes or standards my opponent violated, to 
make those obligations "real" to the jury. 
 
Initially, don't concern yourself with appearance or order.  Also, don’t waste time on 
bells and whistles like animated titling or sound effects.  Just load every visual you 
might use into the presentation, resizing the images for effective viewing.  At this stage, 
the program is just a vessel to hold your visual anchors.  As you gather new visuals, 
insert them into the presentation—and make sure you periodically back up your work.  
Don't forget audio evidence, too.  Voice mail, recorded statements, and 911 calls can all 
be dropped into PowerPoint. 
 
Once your visual evidence and demonstrative exhibits are in PowerPoint, you can easily 
get to them.  Though PowerPoint is a linear presentation tool, it also provides direct 
access to any slide (type the slide number, then hit "Enter") and can hyperlink from any 
object in any slide to any other slide, file, or external application.  As the case develops, 
you'll return frequently to your presentation—to show a photo to a witness, a medical 
illustration to a doctor, or a deposition video clip to the court during a motion hearing.  
Along the way, you'll add titles, labels, highlighting, and animation, as well as determine 
the slides' order, keeping what works and dropping what doesn't.  The presentation 
evolves with the case, and a polished presentation emerges gradually as your skill level 
grows.   
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Video 
Most video needs editing before you show it to a jury, and video depositions are more 
effective when distilled to a 15- to 30-minute excerpt.  Once, lawyers had to hire 
expensive video editors or manage a crude edit with two VCRs.  Now, computers, 
digital camcorders, video-capture devices, and video-editing software have made video 
production relatively cheap and easy.  Full-featured video-editing programs like 
Microsoft's Windows Movie Maker 2 can be downloaded for free, and many excellent 
products cost less than $100.  A new product, Adobe Premiere Elements does just 
about everything its powerful older brother, Adobe Premiere, can do but for a fraction of 
the price.  
 
This software can also breathe life into static images.  You can use the pan, fade, and 
transition features of a video-editing program on scanned photos and drawings to inject 
a Ken Burns-style dynamic element.  Adding suitable background music may touch 
hearts in mediation or final argument. 
 
Once you have digitized video, the magic begins.  You can drag-and-drop video 
segments directly into PowerPoint or use hyperlinks to connect the presentation to 
video segments stored on CD or DVD.  In PowerPoint, video objects can be 
manipulated like almost any other 
graphic—animated onscreen or started 
and stopped in a carefully orchestrated 
sequence.  A compelling technique for 
mediation or final argument might be a 
slide where headshots of eyewitnesses 
appear like still photos in an album, then 
leap to life, one after another, testifying 
about the same key issue. 
 
Animation 
The ability to animate text (and "enhance" it with grating sound effects like screeching 
tires) has long been overused in PowerPoint presentations.  The animated effect that's 
intriguing the first time you see it is like fingernails on a blackboard by the 10th time.  
Animation is banal and distracting when misused, but when done right it's stunningly 
effective at increasing comprehension and drawing attention to what's important. 
 
The enhanced animation capabilities added to PowerPoint in versions 2002 and 2003 
offer better ways to bounce text on, off, and around the screen.    But, PowerPoint 
animation is capable of so much more.   Now, you can make objects on a slide fade in 
or out, change in size, or follow a precise path.  More important, you can animate 
multiple objects at the same time and tightly control their appearances, movements, and 
disappearances.  You can also apply animation effects to the same object 
simultaneously, allowing, for example, an object to follow a defined path while also 
rotating and growing. 
 

A compelling technique for 
mediation or final argument might 
be a slide where headshots of 
eyewitnesses appear like still 
photos in an album, then leap to 
life, one after another, testifying 
about the same key issue. 
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Building your animation skills will 
take time and experimentation, but 
the unexpected benefit is that it's 
a great deal of creative fun. 

With a little patient tinkering and creative thought, any PowerPoint user can turn out 
animations rivaling those once produced only by professionals.  You can animate 
complex mechanical processes, reconstruct auto and air crashes, depict needed safety 
features in operation, or re-enact medical procedures.  I've used PowerPoint to animate 
a petrochemical plant explosion, the operation of a computer's hard drive, and a 
collision at an intersection.  It was easy to bring an investigating officer's drawing of the 
scene to life, making his hand-drawn cars collide as if the police report were enchanted.  
Adding the screeching tires sound effect to that presentation made a point!  
 
You may question whether animations created by an attorney rather than an expert are 
admissible as evidence.  Most of the time, it doesn’t matter because ninety percent of all 
cases never get to trial.  Moreover, if there is a competent sponsoring witness who can 
vouch for the fairness and accuracy of your animation, most judges will allow their use 
irrespective of who created it.   Savvy opponents will know to object if the animation 
distorts reality, but many will just let it roll in unchallenged.   When all else fails, seek to 
use it with an appropriate limiting instruction. 
 
To experiment with this type of animation, open a blank PowerPoint document and 
begin by drawing a rectangle to represent a car.  PowerPoint includes a toolbar of basic 
drawing tools (if you don't see it on-screen, choose the "View" menu and select 
"Toolbars," then "Drawing").  Right-click on the rectangle and choose "Custom 
Animation" from the pop-up menu.  Select "Add Effect," then "Add Motion Paths," "Draw 
Custom Paths," and "Curve." 
 
Click on the center of the rectangle and drag a motion path for the object to follow, 
clicking at every point where you'd like your "car" to change direction.  You may want to 
superimpose some rotation on the object to better mimic the real world.  Left-click on 
the rectangle and again select "Add Effect" from the "Custom Animation" menu, then 
"Emphasis" and "Spin." Menu options allow 
you to adjust the amount, speed, and 
direction of spin.  You can instruct the spin to 
start with the motion path you've previously 
created (select "Start with Previous").  Now 
adjust the settings to achieve fluid movement. 
 
Once you know how to animate an object, you can layer multiple effects or animate 
several objects at once or according to a time line you control.  This conceptual version 
of the wreck built with rectangles may suffice, but you might want to increase the 
sophistication of your image: Apply the same techniques to create, for example, an 
aerial view of a vehicle animated against a background of an aerial photo of the 
accident scene. 
 
Building these skills will take time and experimentation, but the unexpected benefit is 
that it's a great deal of creative fun.  Plus, imagine the intimidation factor when your 
opponent learns who created those animations that so impressed the adjuster! 
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Presentation Tips 
When presenting documents with PowerPoint, show the jurors the untouched document 
as scanned, before adding any lines, boxes, circles, or other embellishments.  If the 
original document is in evidence, assure jurors that they will be able to see it.  Never 
enhance a document with PowerPoint in a way that might be construed as concealing 
or misrepresenting evidence.  Juries are quick to fault counsel who appears to be hiding 
anything. 
 
Remember, the documentary evidence with which you are intimately familiar is brand-
new to the jurors.  People read at different speeds, and no one will be happy if you 
remove a document before he or she is through reading it.  Adjust your presentation 
pace to the jury's and don't go to the next slide or enhancement until the entire panel is 
ready. 
 
Even the best on-screen presentation can strain eyes, necks, and attention spans if it 
goes on too long.  Use variety in presenting exhibits.  Break up your presentation with 
flip charts, three-dimensional evidence, even the familiar blowup mounted on a foam 
board. 
 
Depart from the on-screen presentation to underscore the importance of key evidence.  
For example, if one document is the smoking gun, don't debut it on-screen, 
undistinguished from other exhibits.  Instead, reverently bring forth the paper original 
and cradle it in your hands like the crown jewels.  The change in focus and format 
spotlights the "in the flesh" evidence. 
 
Many an unprepared presenter has been stymied by the lack of a cable, extension cord 
for AC power, power strip (you will need at least two power connections, three if you 
use amplified speakers), or a small table to hold the projector.  Running cables across 
the floor can create trip-and-fall hazards, so have a large roll of gaffer's tape to secure 
them.  Gaffer's tape doesn't leave a sticky residue like duct tape does, and it's stronger 
and easier to use than masking tape. 
 
If your presentation includes sound, be sure you can tap into the courtroom sound 
system or be sure to bring your own amplified speaker system.  Always check out the 
courtroom well before setup, and plan accordingly.  Remember, just because there is an 
outlet on the wall doesn't guarantee that it has any juice. 
 
Computers are flexible, powerful, and persuasive—but they can fail.   Always have a 
Plan B for those times when the laptop won't boot or the projector bulb burns out.  Have 
a copy of your presentation—and the PowerPoint portable viewer application that 
comes with the program—on a CD-ROM or a thumb drive (a small, removable data 
storage device; sometimes called a jump drive).   That way, you can borrow another 
system and get going again. 
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Keep a spare projector bulb on hand, or have someone (perhaps an audio/visual rental 
company) prepared to bring a working projector to the courthouse.  Know where the 
nearest computer equipment vendors are located, and carry their phone numbers.  In a 
pinch, many laptops can be attached to a television monitor; be sure yours can. 
 
Most important, recognize that the same short attention spans and appetite for 
stimulation that make Gen-X jurors respond well to visual persuasion also give them a 
short fuse when technical snafus delay the proceedings.  Be ready to move on if your 
fixes don't work. 
 
My most successful PowerPoint presentations serve to support and supplement my 
powers of persuasion by clearly and efficiently portraying the evidence and my client’s 
contentions without distortion or distraction.   Digital presentation keeps me from 
forgetting to make a key point.   Freed from using notes, I can more easily engage the 
jurors, use effective gestures and body language and maintain eye contact.   
PowerPoint helps me stay on message, yet remain flexible enough to adapt on the fly 
as the evidence evolves.   Best of all, I know I’m using the visual persuasion jurors find 
most compelling and memorable.   Acquiring a high comfort level with presentation 
technology may take some work, but the effort it demands is rewarded each time I rest 
my case. 
 
 Learning More 

 
You can teach yourself the basics of PowerPoint in a single 
evening, but to hone your skills, check out the specialized 
tutorials found in the PowerPoint area of Microsoft's Web site 
(www.microsoft.com/office/powerpoint/) or review the postings in 
one of the PowerPoint newsgroups, which you can find by 
searching the "Groups" section of most major Web portals, like 
Google, MSN, or Yahoo.   Two good (albeit pricey) books 
specifically for lawyers and each now in second editions are 
available: PowerPoint 2002 for Litigators by Deanne Siemer and 
Frank Rothschild (National Institute for Trial Advocacy, $69.95), 
and Persuasive Computer Presentations: The Essential Guide for 
Lawyers by Ann Brenden and John Goodhue (American Bar 
Association Law Practice Management Section, $79.95). 
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      Six Ways to Add PowerPoint Pizzazz to Mundane Documents 
 
Ever watched a trial on television?  Not on one of those reality shows or Court TV, but 
the trials on “The Practice” or “Law and Order.”  Of course, a real trial can’t fairly be 
compared to those steroidal spectacles, but don’t you know that the dramatic and fast-
moving trials on the tube foster high expectations in real-life jurors?  We can’t meet all 
those media-stoked expectations, but there’s one we can meet: we don’t have to be 
boring!   A trial lawyer’s greatest enemy is boredom. 
 
One way to beat back the boring trial is to add digital dash to routine documentary 
evidence with presentation software packages like Microsoft’s PowerPoint.  You 
probably already own a copy of PowerPoint, either because it came with a computer or 
as part of Microsoft Office.  If it’s gathering dust on your system, why not put it to work 
enhancing the sort of mundane documents lawyers work with every day?  If you have 
Corel Presentations, you can use it to create these enhancements, though the steps will 
be a little different. 
 
What You’re Going to Need 
 
Tools to Create the Enhancements 
You don’t need much to get started, and chances are you already have it all: 
 
Computer 
If the computer you have now is a PC successfully running Windows with any flavor of 
operating system from Windows 98 forward (e.g., Windows 98, ME, XT, 2000 or XP), or 
if you’re using a late-model Mac, you’ve got all the computing power you need to do the 
tasks discussed in this article.  If you’re still running Windows 95 or if your processor 
speed is under 450MHz, you’re overdue to treat yourself to a new system.  Prices have 
tumbled so far, you’ll be amazed at what you can get for under $600.00, but be sure 
whatever you buy has a CD-RW drive or, better yet, a DVD recorder that will allow you 
to burn larger PowerPoint presentations onto a CD for portability. 
 
People often ask me what kind of computer they should buy.  I recommend electric 
(because the diesel-powered kinds tend to run hot).  Seriously, there’s no pat answer--
what you buy depends upon what you plan to do with it.  Typical applications, like e-
mail, word processing, bookkeeping and web surfing, place only modest demands on a 
computer, enabling you to get by with almost any “starter” PC being sold today.  
Although Microsoft’s recommendations are less demanding, for PowerPoint 2003 I 
recommend a system running a one gigahertz or faster processor, with at least 256 
megabytes of memory (RAM) and 32 MB or more of video memory (VRAM).  For the 
courtroom, choose a quality laptop over a desktop.  Toshiba, IBM, Gateway and Dell 
currently make the best and most reliable laptops.   
 
Within two years, anything you buy now will be obsolete by the standards of the 
marketplace.  However, today’s purchase will likely meet all of your computing needs for 



Craig Ball  Power Persuasion  

                      Text © 2006 Craig Ball 
    

16

at least twice that period of time, at which point power-hungry new releases of your key 
software will likely favor replacement.  That’s been the typical computing scenario for a 
number of years.  You may as well buy it now.   

  
PowerPoint Software 
The latest version is still PowerPoint 2003, included in all flavors of the Office XP 
software suite and also sold as a standalone application.  It is, in almost every respect, 
indistinguishable from PowerPoint 2002 and doesn’t justify upgrading unless you 
collaborate on presentations or burn them to CD-ROMs.  If you have an older version of 
PowerPoint, like PowerPoint 97 or 2000, it will do but, in this instance, the upgrade is 
definitely worth it.  The latest versions have more sophisticated animation tools that add 
real polish to your presentations once you become familiar with the program. 
 
Document Scanner 
This is where folks start to get nervous about whether they have the right scanner.  
Don’t.  Let me put it this way; if your scanner is less than about five years old and cost 
you more than thirty bucks, it’s almost certainly up to the task.  If I had to make a 
recommendation, any current USB-compatible model made by Visioneer or Hewlett-
Packard is a sound choice.  I’m very happy with my Visioneer 9650 because of its 
handy and reliable automatic document feeder, but the lower end (<$100.00) devices 
sold at the local Wal-Mart or Target store will work too.  Most people’s unhappy 
experiences with scanners involved their use as optical character recognition (OCR) 
devices. Here, we are just using the scanner to create an image of a document, not 
read its contents and convert them to a word processor-compatible format.   The latter 
can be tricky, but the first is a breeze. 
 
Tools to Present Your Work 
Once you’ve created lively documents, you’re going to want to display them.  There are 
several ways to do so, ranging from printing out your work on a transparency and using 
an overhead projector to putting them on a standard television screen to just gathering a 
small audience around your laptop display.  But, the best approach by far (and, of 
course, the most expensive) is to use a laptop computer, digital video projector and 
screen. 
 
Laptop Computer 
You don’t have to use a laptop to display your PowerPoint, but those clunky desktop 
systems and monitors are a pain in the neck to transport, and handheld alternatives 
(like MARGI Systems’ Presenter-to-Go) may limit your ability to use animation, 
transitions and multimedia.  In a courtroom setting, a laptop allows you to make 
changes to your presentation on-the-fly according to what comes into evidence and 
pronouncements from the bench—flexibility that’s essential if you want what you create 
to get into evidence.   
 
The same criteria advanced above for selecting a computer apply to choosing a laptop, 
but there are a few unique wrinkles.  The laptop you choose must have a VGA output to 
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carry its screen contents to a digital video projector (most include it, but a handful of 
ultra portables relegate this all-important output to a docking station).  A DVD-ROM or 
thumb drive is also a must because you will quickly find your PowerPoint presentations 
growing too large to fit on a floppy disk.  I favor laptops that offer a composite video 
(NTSC) output allowing me to connect directly to the monitor input of a conventional 
television set when a digital projector is unavailable.  A hefty ration of video memory 
(>32MB VRAM) associated with the laptop’s video adapter helps PowerPoint 
presentations run smoothly, especially when you’re dealing with video and animation. 
 
Before you buy a new laptop, be sure to take a look at the latest tablet PCs.  The ability 
to pivot the screen away from the keyboard and to write directly on the screen is a plus 
for use in court and at mediation.  The Gateway M280E, introduced late in 2005, is 
state-of-the-art in portable power and tablet features, including a dual layer DVD burner, 
64MB VRAM and a 100GB hard drive, all in a tablet form factor. 
 
Digital Video Projector 
Although they have come down quite-a-bit in price, digital video projectors are costly, 
ranging from under $1,000.00 to $6,000.00 or more, depending upon size, brightness 
and features.  Just a replacement bulb for one of these gadgets can set you back 
hundreds of dollars!  Accordingly, infrequent users elect to borrow or rent a projector as 
needed.  More and more, courthouses, mediators and bar groups are making these 
devices available.  Ask around.   
 
If you decide to buy your own projector, it should support a minimum native XGA (1024 
x 768) resolution and 1200 ANSI lumens image brightness.  Less bright units can be 
troublesome in courtrooms with lots of ambient light.  Keystone correction helps you to 
compensate for awkward courtroom arrangements and a remote control affords you a 
longer leash. 
 
Projection Screen 
The lowest tech part of the package can make a substantial difference to the success of 
your presentation.  Higher quality screens have higher reflectivity, returning more of the 
projected image to the viewer’s eye and making for a brighter appearance.  Courtrooms 
are notoriously challenging places to set up a projection screen without figuratively 
treading on someone’s toes.  As soon as you begin using projection in your 
presentations, you will appreciate the universal reluctance to accept a less-than-
optimum viewpoint.  Trying to set up such that jury, judge, opposing counsel and court 
reporter are all well-served is no mean feat with a single projector and screen, and to do 
so may require a little creative choreography and the indulgence of the court.  
Sometimes, a projector and screen that support rear projection are useful solutions. 
 
Since we are working with documents, you will want to get as large a screen as will 
work given the dimensions and layout of the courtroom and the distance between 
projector and screen.  I’m partial to the Deluxe Insta-Theater line of screens from Da-
Lite Corporation (http://www.dalite.com) because of their ease of set up and integral 



Craig Ball  Power Persuasion  

                      Text © 2006 Craig Ball 
    

18

aluminum case.  Here again, many venues already have screens available for your use; 
but, be sure it’s what you need and where you need it before leaving your screen at the 
office.   
 
Miscellany 
Many an unprepared presenter has been stymied by the lack of a cable, extension cord 
for AC power, power strip (because you’re going to need at least two power 
connections, three if you use amplified speakers) or even just a small table on which to 
place the projector.  Running cables across the floor can create trip-and-fall hazards, so 
a large roll of gaffer’s tape is worth having on hand to tape them down.  Gaffer’s tape 
doesn’t leave the sticky residue of duct tape, and it’s stronger and easier to use than 
masking tape (though all will suffice in a pinch).  If your presentation includes sound, 
consider whether you can plug into the room sound system or if you will need to furnish 
and position amplified speakers.  Always check out the courtroom sufficiently in 
advance of set up and plan accordingly.  Anticipate complications—a bulb burning out, 
a computer malfunction--and have a back up plan ready.  Finally, remember that just 
because there is an outlet on the wall doesn’t guarantee that it’s got any juice! 
 
Getting Started 
 
Scanning the Document 
The first step to adding pizzazz to a mundane document is getting the document in a 
digital format that can be dragged, dropped and manipulated in PowerPoint.   A scanner 
takes a picture of a document and converts that document image to a file in a particular 
computer-readable graphic format.    
 
File Formats 
Though some scanners use proprietary formats incompatible with other applications, all 
support the ability to save or export an image to one of the many standard graphics 
formats.  For our purposes, we want to save the scanned image as a JPEG 
(pronounced jay-peg and also abbreviated JPG), PNG or TIFF.  Consult your scanner’s 
manual or help file to ascertain how to create these formats with your model.  If your 
scanner is set to scan directly to the Adobe Portable Document Format (PDF), note that 
the Adobe Acrobat program allows you to export to JPEG, PNG and TIFF. 
 
Although it’s common to use the JPEG format for scanned photographs and the TIFF 
format for scanned documents, I tend to use JPEG for both since JPEG tends to create 
the smallest file size.  I recommend you stick with JPEGs unless your results are 
unsatisfactory.  A common PowerPoint mistake is creating and using too large an image 
file for a given document when a smaller file would suffice.  As the number of slides in 
your PowerPoint presentation grows, these unnecessarily large images start to slow the 
program and can adversely impact the presentation.  Setting your scanner to create the 
optimum file size from the start can prevent headaches later on. 
 
Scan Resolution 
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Figure 1: PowerPoint Main Screen 

Your scanner will allow you to set the resolution and color depth at which it scans.  
Resolution is measured in dots-per-inch (dpi).  For an ordinary business document, 
scanning at a resolution greater than 150 dpi does little to enhance your presentation 
and saddles you with an excessively large file.  You may be satisfied with a scan at 75 
dpi, so play around with the settings to find the best balance between file size and 
legibility.  Gravitate to higher resolutions only when you anticipate greatly enlarging a 
small area of your document in a call out (more about this later). 
 
Color Depth 
Color depth describes the amount of data assigned to each picture element (“pixel”) in 
an image.  If a pixel can only be black or white, then you only need a single binary digit 
(“bit”) to describe it, but if it be any of millions of colors, the string of data needed to 
describe the color is very large.  Multiply that data times the thousands or millions of 
pixels in a scanned image and you’ll have some notion why color depth settings 
dramatically influence file size.  Unless your document is in color, there is no need to 
choose a color depth setting other than “grayscale.”  Even for documents with 
highlighting, colored logos or marginalia in colored ink, a color depth no greater than 
256 is almost always sufficient and will optimize file size.  Just as too much color depth 
is undesirable, too little can produce unacceptable scans.  Choosing the “black and 
white” color depth setting for many documents frequently results in a harsh, high-
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Figure 3: Insert Picture Button 

Figure 4: Picture Selection Window 

 
Figure 2: Insert Picture Menu 

contrast image unfaithful to the original—much like a late-generation generation 
photocopy.  Stick to grayscale where possible. 
 
Getting Scanned Documents into PowerPoint 
As a rule, there are three ways to accomplish 
almost anything in PowerPoint.  You can select 
the desired action from the menu bar.  You can 
use a keyboard shortcut—a key combination that 
initiates the desired action.  You can use the 
mouse to drag-and-drop or select an action icon 
from the toolbar.  To better understand this 
flexibility requires an acquaintance with the 
program’s interface.  PowerPoint allows users to 
customize the way the program’s many menus 
and icons appear on their screen; consequently, 
your screen may look a bit different than Figure 
1 (preceding page), but rest assured the buttons 
and menu choices I describe are there, if you 
hunt around a bit. 
 
Although PowerPoint 2002 supports scanning directly into 
your presentation, these examples assume you’ve 
scanned your document, named the file and saved it as a 
JPEG.  If so, start PowerPoint and, if asked, select “Blank 
Presentation” and “Blank Slide.”  To insert your scanned 
document into the blank slide represented by the large 
white box filling most of your screen, select “Insert” on 
the menu bar, then “Picture,” then “From File.”  (Fig. 2).  
From this point forward, let’s simplify a selection 
sequence like this one by expressing it as 
Insert>Picture>From File.  You can have achieved the 
same result by simply clicking the “Insert 
Picture” button on the Drawing Toolbar. (Fig. 
3).  Either way, the program will open a picture 
selection window (Figure 4) for you to locate 
and select your scanned document.   
Remember: your scan is a picture of the 
document, not its text.  
 
As soon as you select the scanned document, 
it will appear in the slide window and you can 
then reposition it by left mouse clicking and 
dragging it or resize it by clicking and dragging 
on its sizing handles—the small circles at the 
corners of the image.  Be sure and resize using just the corner handles as using the 
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side handles will distort the aspect ratio of the document.  By right clicking on the image 
and selecting “Format Document,” the menu which appears affords you considerable 
control over image attributes  including (by selecting the menu’s “Picture” tab) the 
ability to adjust the brightness and contrast of the image.  This is a quick, handy way to 
improve the legibility of washed-out or too-dark images. 
 
Backgrounds 
It’s a good bet that your inserted document is a white piece of paper sitting atop a white 
background.  Documents tend to get lost on the page when this happens.  Instead, 
make your document stand out by changing to a darker background.  To do so, simply 
select Format>Background from the menu, then click the down arrow on the right side 
of the colored block.  If you don’t see the background color you prefer, click on “More 
Colors” and a color wheel will appear.  Then just select the background color you want 
by clicking on it.  Close the selection menus by clicking “Okay” and then “Apply.”  I tend 
to use plain black backgrounds with white documents, but any dark color will suffice to 
help the viewers to focus. 
 
Document Enhancement Techniques 
The first thing you might notice about the scanned document you inserted in your 
PowerPoint is that it’s pretty hard to read, particularly if it is mostly 10- or 12 point typed 
text.  Don’t worry about that.  If your documentary evidence is like most, only a few key 
words or passages are crucial to your case.  They’re what you want the viewer to 
remember.  The rest of this article will describe half a dozen easy-to-master document 
enhancement techniques that will help a viewer to identify, understand and recall the 
parts of the document you wish to emphasize.  These techniques are: 

• Underlining and line linking; 
• Boxing and circling; 
• Retyped call outs; 
• Zoomed call outs; 
• Transparent coloration; and, 
• Negative Coloration 

 
Caveat 
Juries are very sensitive to the notion that a lawyer may seek to keep information from 
them, and they are quick to fault counsel who appears to be hiding anything.  
Consequently, never use an enhancement in a way that might be construed as 
concealing or misrepresenting evidence.  When presenting documents via PowerPoint, 
it’s important to begin by affording the jurors a view of the scanned document; that is, 
the entire page in its pristine condition, before any lines, boxes, circles or other 
embellishments.  If permissible and accurate, assure the jury that the original of the 
document is in evidence and will be available to them to be reviewed in its entirety.  
Remember also that documentary evidence with which you are intimately familiar is 
brand new to the jurors.  People read at different speeds, and everyone responds 
negatively when a document is taken away from them before they are through reading 
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it.  Adjust your pace to the jury’s.  Don’t allow your PowerPoint presentation to proceed 
to the next slide or enhancement until the entire panel is ready. 
 
Break It Up 
Even the best onscreen presentation can get tedious and strain eyes, necks and 
attention spans if it goes on too long.  Strive to employ varied ways to present exhibits.  
Break up your presentation with the old reliable flip chart, three-dimensional evidence, 
even the familiar blow up on foam core board.  Use a departure from onscreen 
presentation to underscore the import of key evidence.  For example, if one document is 
the smoking gun, don’t debut it onscreen, undistinguished from all other exhibits.  
Instead, reverently bring forth the paper original and cradle this all-important exhibit in 
your hands like the crown jewels.  The changes in focus and format spotlight the “in the 
flesh” evidence. 
 
Have a Plan B 
It’s flexible, powerful and persuasive.  But it’s still a computer, so you must have a Plan 
B in place for those terrifying times when the laptop won’t boot or the projector’s bulb 
burns out.  Be sure to have a copy of your presentation (and the PowerPoint portable 
viewer application that comes with the program) on a CD-ROM or a thumb drive.  Then, 
at least you can borrow another system and get going again.  Keep a spare projector 
bulb on hand, or have someone—perhaps an audio/visual rental company—standing by 
to bring a working projector to the courthouse.  Know where the nearest computer 
equipment vendors are located and keep their phone numbers at hand.  In a pinch, 
many laptops can be attached to a television monitor, so be sure you select one that 
can.  Most importantly, know that the same short attention spans and appetite for 
stimulation that make Gen-X jurors respond to visual persuasion give them a short fuse 
when technical snafus delay the proceedings.  Be ready to move on if the first few fixes 
don’t take. 
 
Underlining and Line Linking 
If you were passing a document on to someone and you wanted to draw attention to 
something in it, you’d probably draw an arrow to that part, underline it, color it with a 
highlighting marker or maybe draw a circle or box around it. Simple, effective computer 
enhancement techniques are instantly clear because they do much the same thing. 
 
Suppose you want to draw attention to certain passages in a document by underlining 
them.   All you need to do is click a few icons on the Drawing Toolbar near the bottom of 
the PowerPoint screen (Fig. 5), drag your mouse across the pertinent places in the 
document and you’re there.  The same is true for drawing pointers, lines and arrows.  
Let’s walk through it step-by-step. 

 

 
Figure 5: Drawing Toolbar 
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Figure 9: Arrow Style Tool 

Underscoring 
Once you’ve inserted your scanned document into your 
PowerPoint presentation and determined what passage 
you want to underscore, simply click the “Line” tool icon 
on the Drawing Toolbar (Fig. 6) and place your mouse 
pointer at the beginning of the passage you want to 
underline.  Note that when you selected the line tool, 
your mouse pointer turned into a set of crosshairs.  Click 
and hold the left mouse button while you drag the crosshairs toward the end of the line 
or passage.  When you release the mouse button, a line should appear under the text.  
HINT: I like to hold down the Shift key while I do this because it forces the program to 
draw a perfectly straight line (unlike me, PowerPoint can draw a straight line!).  
 
To change the thickness of the line you’ve just drawn, click the   
“Line Style” button (Fig. 7) on the Drawing Toolbar and pick 
the line thickness and style you prefer.  To change the color of 
the line, click the “Line Color” button (Fig. 8) on the Drawing 
Toolbar and click the color you want.  Repeat this procedure 
as often as needed to underscore all the text you want to 
emphasize.  If you need to change a line previously drawn, 
select it by placing your mouse pointer on the line and left 
clicking.  The line is selected when sizing handles (tiny circles) 
appear on each end.  You can select multiple lines by holding 
down the Shift key while you select them or by holding down 
the left mouse button and dragging a box around them. 
  
Don’t fret if you underline the wrong passage or mess up in some other way.  The most 
marvelous keyboard shortcut in PowerPoint (and most other Windows applications) is 
Ctrl-Z, because it undoes the last thing you did.  Hit Ctrl-Z several times, and Windows 
undoes the last several things you did.  Want to redo something you’ve undone? No 
problem, just hit Ctrl-Y.  These two keyboard shortcuts will spare you a lot of frustration.  
Naturally, you can access Undo and Redo from the Edit menu too.    
  
Arrows 
Drawing an arrow is as easy as underscoring.  Just left mouse click the “Arrow” tool 
icon on the Drawing Toolbar (Fig. 6), then click and drag the crosshairs from the place 
where you want the end point of the arrow to be to the place where you want the 
arrowhead to be.  Voila!  If you didn’t get your arrow position exactly as desired, it’s no 
problem.  You can click and drag the sizing handles to reposition the endpoints or you 
can click and drag on the shaft of the arrow to move the entire arrow.  Once you’ve got 
it where you want it, you can customize everything about 
the arrow you’ve just drawn.  While the arrow is still 
selected (or after selecting it by left mouse clicking on the 
shaft of the arrow), click the “Arrow Style” tool icon on the 
Drawing Toolbar (Fig. 9) and select the arrowhead size 

 
Figure 6: Line and Arrow Tools 

 
Figure 8: Line Color Tool 

 
Figure 7: Line Style Tool
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Figure 10: Arrow Linking Documents 

and style and line thickness and style you prefer.  As with most actions in PowerPoint, 
you can achieve the same result in various ways, e.g., you could double click the arrow 
to bring up the Arrow Style options menu.  You could also select Format>AutoShape 
from the Menu Bar or hit ALT-O twice to get to the same place.  More than one way to 
skin a cat! 
 
Linking 
Sometimes you need to draw attention to a 
relationship between parts of the same 
document or between two documents.  The 
line and arrow drawing techniques are well-
suited to these tasks.  Try drawing a line or a 
two-headed arrow between two parts of a 
single document or experiment with inserting 
two scanned documents side-by-side on the 
same PowerPoint slide, then drawing draw 
lines and arrows between them, as in Fig. 10. 
 
Animating Enhancements 
Much of the power in PowerPoint lies in its ability to animate screen objects.  Judicious 
use of PowerPoint animation permits you to control the flow and focus of your 
presentation while adding kinetic interest—pizzazz—to static and mundane evidence.  
Movement can be used to express passage of time, 
exchange of consideration, trajectory of a bullet, flow of 
product through a pipeline, routes taken by vehicles, 
propagation of a family tree or crossing off items on a list, 
just to name a few.  Once you develop a comfort level 
with PowerPoint animation, all sorts of creative uses will 
occur to you, but use care to insure the animation doesn’t 
get in the way of the message.  A frequent mistake of 
PowerPoint users is an infatuation with pointless 
animation.  If your text or enhancement doesn’t need to 
bounce or tumble into the slide, then don’t do it!   
Animation should be as subtle as possible (or entirely 
absent where it serves no purpose).  Don’t cry wolf!  
Reserve dramatic animation for emphasis of dramatic 
points, and be mindful of objections to inappropriate 
emphasis.   What you can do in argument you may be 
prohibited from doing in jury selection or with a witness. 
 
To add animation to a line, arrow or any screen object, 
right click on the line, arrow or object, then select 
“Custom Animation.”  The Custom Animation menu will 
appear (Fig. 11).  In PowerPoint 2002, you would then 
select “Add Effect” and be prompted to choose an animation effect from any of four 

 

 
Figure 11: Animation Menu 
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Figure 13: Rectangle and Oval Tools 

categories of effects: Entrance, Emphasis, Exit or Motion Paths (Fig. 12).  Entrance 
effects set the way in which a screen object 
appears on your slide.  Emphasis effects 
animate objects while onscreen, leaving 
them onscreen after animation.  Exit effects 
set the way in which a screen object leaves 
the slide, and Motion Paths enable an 
object to move around the screen during 
presentation on a path you select or create.  
When you select “Entrance,” a partial list of 
entrance effects will appear.  If you don’t 
see the entrance effect you want on the 
partial menu, select “More Effects” for a 
complete list.  For example, to cause the 
arrow in Figure 10 to appear to be drawn 
from the typed name to the signature, right 
click the arrow, select Custom 
Animation>Add Effect>Entrance, then 
select the Wipe effect as its entrance 
animation effect.  I could then customize 
the animation, selecting “From Left” from 
the “Direction” option (so the arrow 
appears to be drawn from left to right) and 
“On Click” from the “Start” options (setting the action that will start drawing the arrow 
across the screen, from name to signature).   If you want to see how the animation will 
look in your presentation, click the “Play” button, or click “Slide Show” to run your 
presentation from the current slide. 
 
The variety of animation options may seem daunting at first blush, but you will quickly 
come to appreciate the high degree of flexibility and creativity these choices afford.  The 
ability to choreograph animation to match the pace of your presentation, apply multiple 
overlapping animation effects to a single object, allow multiple objects to animate at the 
same time, adjust animation speed and control a host of other customization choices is 
invaluable in a courtroom persuasion tool. 
 
Boxing and Circling 
Boxing and circling around text or other features of 
a document—especially when paired with a well-
chosen animation effect like “zoom out slightly”—are 
great ways to focus a viewer’s attention and serve 
as the perfect preludes to the text callouts described 
later in this paper. 
 
To draw a box or circle around text, click either the 
Rectangle or Oval tool on the drawing toolbar (Fig. 13).  Then, in the slide window, 

 
Figure 12: Entrance Animation Selection
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Figure 14: Move Pointer

 

 
Figure 15: Text Box Tool 

click and drag a rectangle or oval around the passage to be highlighted.  Don’t worry 
about perfect size or placement just yet as the shape you’ve drawn needs a little work.  
First, the shape is, by default, filled with an aqua color that blocks the text.  To clear this 
fill color and make the box or circle transparent, find the Fill Color paint bucket icon on 
the drawing toolbar and click on the down arrow to its right, then select “No Fill.”  Now, 
just as we did before, use the “Line Style” (Fig. 7) and “Line Color” (Fig. 8) tools on the 
Drawing Toolbar to select the line thickness, style and color you prefer.  Use the sizing 
handles to precisely size and position your shape and enclose the text or other content 
you want to emphasize.   I find a red or yellow line at six point thickness works well.  
TIP:  If you want the shape you draw to be a perfect square or circle, hold down the 
Shift key while you draw it.  This will maintain the correct aspect ratio and keep you from 
inadvertently drawing a rectangle or oval. 
 
Positioning 
Although the sizing handles will suffice for positioning most enhancements, sometimes 
you just want to grab and move an enhancement without (or before) resizing it.  As in 
many Windows applications, when you left click on and select the shape you’ve drawn, 
you will note that, when you position your mouse pointer anywhere on a filled object or 
on the fuzzy outline edge of an unfilled shape, your pointer changes to the Move 
pointer, a four-pointed arrow like that in Figure 14.  While the 
move pointer is visible, you can left click and drag the object 
anywhere on or off the slide.  You can also use the arrow 
(cursor) keys to nudge the object in precise increments and 
in even finer increments if you nudge it while holding down 
the CTRL key.   
 
Animating your Box or Circle 
The procedure for adding an animation effect to your enhancement is really no different 
for a box or circle than it was for a line; however, one entrance effect I highly 
recommend is “Zoom,” with the zoom method set to “Out Slightly.”   This causes your 
outline to appear somewhat larger than the document region to be enhanced and then 
contract until it stops at the dimensions you selected.  It’s quick and clear, without being 
distracting. 
 
Adding Text   
So far, these exercises have centered on overlaying simple 
line drawings like boxes on top of scanned documents.  But, 
sometimes you need to put text in those boxes, or perhaps 
annotate a scanned photograph.  Creating a text box is as 
simple as clicking on the “Text Box” icon on the drawing 
toolbar (Fig. 15) and drawing a text box in the same way you 
created an empty box, except the box you create with the 
text box can contain—big surprise here—text! 
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Figure 17: Retyped Callout 

 
Figure 16: Font Color Tool 

To create a text box, just click the Text Box icon, position your pointer (which now looks 
like an arrow pointing down to the baseline of your text) on the slide, draw the rough 
outline of the box and start typing your text.  You can control, text color, font size and 
style and a host of other text options in PowerPoint exactly as you do it in other 
Microsoft Office application.  Note that the drawing toolbar 
contains a handy “Font Color” icon (Fig. 16), but, of 
course, you can also add and customize text boxes using 
the Insert and Format options on the menu bar.   You can 
also animate text boxes and their contents as you would 
any other object on a PowerPoint slide. 
 
Callouts 
Boxing or underlining text is useful, unless the highlighted text is so small onscreen that 
viewers can’t read it.  This is a common issue when working with letter size documents 
on PowerPoint slides, but one that can be resolved easily by adding callouts to your 
slide.  You’ve probably seen callouts before, likely added to documentary evidence 
that’s been blown up and mounted on foam core board.  A callout simply denotes and 
magnifies selected text in a document, usually displaying it in the margin at a size 
sufficiently large to allow jurors to read the passage “called out” from the page.  
Mounted document enlargements with callouts are effective and they still have their 
place in your arsenal of demonstrative evidence; however, they have drawbacks, too.  
Mounted enlargements with callouts are expensive, running anywhere from $150.00-
$400.00 per page.  They can be tricky to transport, especially on a windy day, they 
require easels, and they are set in stone (well, in foam, anyway) and can’t be altered on 
the fly when the court orders particular matters excluded.  On the other hand, you don’t 
have to boot them up, you don’t need a projector and they never crash, except perhaps 
on those same windy days! 
 
Callouts fall in two varieties, which I distinguish as “Retyped Callouts” or “Zoomed 
Callouts.”  The difference between them is that the text called out in a retyped callout 
has been keyed into the text box.  In a zoomed callout, the text called out is an enlarged 
segment of the document.  Each has their advantages.  A retyped callout is usually 
easier to read and to fit on a slide without 
obscuring the source document.  A zoomed 
callout is the “real” document and, for some, 
that makes it more persuasive.  Where there 
is any question about what the document 
says (as occurs with handwriting or poor 
copies), zoomed callouts forestall claims of 
misrepresentation.  Where legibility is an 
issue, the retyped callout has the edge. 
 
Retyped Callouts 
To create a retyped callout like that shown in 
Fig. 17, insert your source document in the 
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Figure 19: Zoomed Callout 

 
Figure 18: Callouts Menu 

slide and box the text to be highlighted using the techniques previously described.  Be 
sure to resize the document to afford room for your callout, unless you want the callout 
to cover part of the source document.   
 
There are then two ways to complete your callout.  The simplest is to use PowerPoint 
2000 and 2002’s built-in callout feature.  To do so, click “AutoShapes” on the drawing 
toolbar and select “Callouts” from the 
AutoShapes menu (Fig. 18).  Choose the 
style of callout you prefer, then click and drag 
from the edge of your boxed text to the 
margin area reserved for your callout.  
PowerPoint will create a filled text box ready 
for your insertion of the highlighted text by 
retyping it into the text box.  Before you start 
typing, resize and reposition the text box for 
the best appearance.  You can also use the 
drawing toolbar to change the text box’s 
background color.  Use the “Font Color” tool 
to select the color for your text before you 
type because if both background and text 
colors happen to match, you won’t see your 
text at all. 
 
The second way to fashion a retyped callout is to combine the skills you learned 
previously to draw a line or arrow combined with a text box.  Doing so can give you a bit 
more precise control over the individual stylistic elements of the callout; but for those 
whose copy of PowerPoint includes the callouts feature, using the feature is easier and 
faster. 
 
Zoomed Callouts 
Creating a zoomed callout is a bit more 
involved than creating its retyped 
sibling, and sometimes the results are 
less than stellar, especially where the 
source document scan is of poor quality.  
However, a successful zoomed callout 
can be a slick and impressive piece of 
demonstrative evidence, as Fig. 19.  
The trick to a zoomed callout is cutting 
out from a duplicate of the source 
document just the text you want to 
emphasize and then resizing the 
excised text.  To get started, insert your 
source document in the slide and box 
the text to be highlighted using the 
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Figure 20: Crop Tool 

techniques previously described.  Here again, resize the source document to afford 
room for your callout.  Zoomed callouts tend to be about twice as wide as the source 
text, so leave plenty of space below your source document unless you don’t mind the 
callout overlapping and concealing part of the source document.  
 
Now, select your source document (if not already selected) by left mouse clicking on it 
and type CTRL-D to duplicate your source document.  The duplicate should appear 
atop and slightly offset from the source document.  We will use the duplicate to cut out 
the emphasized text.  The duplicate should already be selected, so click on the “Crop” 
tool on the drawing toolbar (Fig. 20).  Note how the sizing 
handles on the duplicate have changed into cropping handles.  
By clicking and dragging on these, you can crop out everything 
on the duplicate document except a rectangle containing your 
emphasized text.  Just crop roughly at first, leaving wider 
margins around the emphasized text than you want in the final 
product, because you can crop again after you’ve enlarged the text.  When finished, 
click the Crop tool button once more, and the cropping handles will again become sizing 
handles.  Click on a corner sizing handle (not a side handle, which will distort the text) 
and stretch the cropped text until it is roughly the size you want for the zoomed callout.  
Note that your text may become somewhat blurred as you enlarge it.  Strike the best 
balance you can between clarity and size.  After you’ve enlarged the selected text, you 
can again click on the Crop tool to fine tune the margins.  It’s should be easier to 
accomplish with precision now that the text is enlarged. 
 
Once your enlarged text is the right size, drag it to its intended location.  You might want 
to box the enlarged text by selecting it, then clicking on the Line Color tool.  You can 
adjust the line thickness, style and color just as before.  Now, to complete your callout, 
just draw a line or an arrow from the edge of the boxed text in your source document to 
the edge of the enlarged text.  
 
Grouping and Animating Callouts 
Judicious use of animation reinforces the impression that the enlarged text is emerging 
from the source document.  To add animation to a callout, you need to employ an 
additional step because callouts are comprised of more than one object, e.g., the boxed 
text, the line or arrow and the text box or enlarged text.  Though you could animate 
each object and adjust their settings to appear simultaneously, the easier approach is to 
“group” the callout objects before you apply an animation effect to them.  To group 
objects, they must first all be selected.  To do so, hold down the Shift key while you 
select each of the objects you wish to group.   Once selected, group the objects in any 
of three ways.  You can group the objects by typing CTRL+SHIFT+G or by clicking the 
word “Draw” on the drawing toolbar and choosing “Group,” or by right clicking on the 
edge of any of the selected objects and selecting Grouping>Group.  Once grouped, the 
selected objects become one object until ungrouped (CTRL+SHIFT+H). 
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Figure 23: Negative Coloration 

 
Figure 22: Colors menu 

 
Figure 21: Transparent Coloration Highlight 

Now that you’ve grouped the callout 
components, apply an animation effect 
to the group.  You might want to use the 
Wipe entrance effect for a retyped 
callout and a Faded Zoom entrance 
effect for the zoomed callout.  You can 
even tier callouts as shown in Fig. 19, 
where the block of text is first enlarged, 
followed by the enlargement of a single 
phrase within the block.  Experiment 
until you find something you like, but 
remember, the goal is communication, 
not coolness. 
 
Transparent Coloration 
When you use the Rectangle tool to box in text, by default 
PowerPoint created a filled rectangle, which you then must 
clear of the fill color to reveal the text below.  What if 
instead you could make the color translucent so that it 
could be used much like a highlighting marker, to 
emphasize blocks of text?  It can (Fig. 21).  When you 
create your rectangle or oval, instead of clearing it by 
clicking on the down arrow to the right of the Fill Color 
paint bucket and selecting “No Fill,” select “the “More Fill 
Colors” option.  This will open the Colors menu, with its 
honeycomb containing all the standard fill colors (Fig. 22).  
Select a suitable highlighting color by clicking on its color 
(bright yellow is always an excellent choice for 
highlighting), and then locate the “Transparency” slider at 
the bottom of the Colors window.  Move the slider to about 
85% transparency. I find the optimal range 
to be something between 70-90% 
transparency, depending upon the highlight 
color selected and the brightness and 
contrast of the document being highlighted.  
Too much transparency and the effect is 
lost, too little and you can’t make out the 
highlighted text through the “haze” of color. 
 
Negative Coloration 
Just as you can emphasize parts of a 
document using transparent coloration, 
conversely you can add emphasis by 
shading the entirety of the document except 
the part you want to highlight.  In Figure 23, 
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the entire document save the emphasized text has been obscured by six black 
rectangles, each abutting another, surrounding the highlighted text, and all set to 75% 
transparency.  Their margins have been eliminated by setting the Line Color to “No 
Line.”  The net effect is that the unshaded area of text jumps out.  Grouping the shading 
rectangles, then using animation effects to fade them in, followed by enlargement of the 
emphasized text in a zoomed callout, is a very effective combination (and one 
frequently used to good effect by many television news shows, in particular “Sixty 
Minutes”). 
 
Last Words 
Keep in mind that the enhancements discussed in this article are just a small sampling 
of the exciting things presentation software can do to enhance your advocacy.  By 
combining the rudimentary drawing skills just discussed—drawing, styling and 
animating lines, arrows, rectangles, ovals and text boxes—you can build increasingly 
complex and interesting enhancements like animated time lines, process drawings, flow 
charts and so on. If you pair your fertile imagination with these basic techniques, plus 
the more advanced ones you will come to know as you experiment with PowerPoint, 
you may find that not only will your presentations be less boring; you might even find 
yourself having a little fun with this stuff! 
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Quick and Easy PowerPoint Timelines  
 
Timelines are visual chronologies that tell a story.  They are tried-and-true persuaders 
with broad application in many kinds of litigation.  In expert hands, a timeline functions 
as the backbone of the evidence--easily understood by every juror and sequentially 
laying out the events in issue.  Timelines also help counsel build a coherent narrative, 
detect and expose inconsistencies and highlight noteworthy clusters of activity and 
inactivity. 
 
Building timelines once meant choosing between hiring a graphics firm and going into 
battle with a felt tip marker and roll of butcher paper.  Today, top-notch timeline creation 
software programs like TimeMap (www.casesoft.com) make timeline creation a snap.  
There is probably no product out there better suited to the task than TimeMap.  But if 
you only have the occasional need to create a timeline, or you want to use a product 
you probably already own, you can make good looking, persuasive timelines in 
PowerPoint.  This paper walks you through the process, step-by-step. 
 
Step One 
Forget templates, and begin, as you always should with PowerPoint, by getting to a 
blank slide.  If PowerPoint included a title or bullet point box on the slide, delete them 
and set either a solid white or black background using the Format>Background menu.  
You can dress things 
up later.  Right now, we 
want to keep it simple 
and construct the 
timeline on the right. 
 
Decide what time span 
you need to depict.  A 
single PowerPoint slide 
isn’t wide enough to 
cover more than about 
a dozen divisions with 
labels horizontally, so 
you may need to insert 
a time break (usually a 
zigzag interruption) to 
indicate that the 
interval is not to scale.  
Alternatively, you can 
break your timeline into 
two slides and use transitions to move between the timeline segments (more on this 
later).  For this exercise, let’s keep the timeline compact enough to fit on one slide. 
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Locate the Drawing toolbar (see above).  If it’s not visible, use the View>Toolbars menu 
to check “Drawing” and it will appear onscreen, either floating free or docked to another 
tool bar.  Using the Rectangle tool on the Drawing toolbar, click and drag a horizontal 
band to serve as our timeline.  Use the Fill Color tool on the Drawing toolbar to select a 
color for the timeline that contrasts with both the background and the text and line colors 
you’ll use.  Steer clear of distracting hues (e.g., violet) and colors like red or green that 
send a message you may not mean to convey.  If you’ll be placing your event labels 
below the timeline, position it about one-third of the way down the page to leave room 
for titles.  If you plan to add event labels both above and below the timeline, center it on 
the slide both vertically and horizontally. 
 
Dividing our Time 
Now, we want to add time division markers.  Though there are many options, keeping it 
simple, we’ll use a series of short vertical lines spaced along the top of the timeline 
rectangle.  Draw the first marker using the Line tool 
on the Drawing toolbar to click and drag the desired 
length of the line.  Because these lines need to be 
perfectly vertical, constrain the line to vertical, 
horizontal or 45º intervals by holding the Shift key 
as you click and drag.  Practice this, as it’s a 
shortcut you’ll use frequently.  When the length is right, use the Line Style and Line 
Color tools on the Drawing toolbar to create a pleasing marker.  Click and drag the 
marker to place it at the top left edge of the time line to denote the start of the interval. 
 
Now, we need eight more identical markers and we want them spaced evenly across 
the timeline.  We could do this manually, but hand drawn will never be exactly the same 
length and the spacing will be hard to get right without a lot of tweaking.  Instead, let 
PowerPoint do the work for you!  Select the marker you just created and type CTRL-D 
(for duplicate).  A perfect copy of the marker should appear, offset by default to the right 
and below the original.  Click and drag on the copy, placing it to the right of the first, 
about 1/8th of the way to the right.  Don’t worry about being precise.  Close enough is 
good enough for now.  Hit CTRL-D six more times and six more perfect copies should 
cascade across the slide, each alongside its predecessor, spacing to the right by about 
1/8th of the line width.  Close to what you want, but probably not close enough. 
 

TIP: Hold the Shift key while 
drawing lines to constrain the 
line to vertical, horizontal or 
by 45º intervals 
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TIP: Use Align and Distribute 
options on the Draw menu to 
get multiple items to line up 
and lay out perfectly. 

To get the spacing and alignment just right, click and 
drag the rightmost marker (the last duplicate) and 
place it at the end of the timeline to denote the end of 
the scale.  Then, while holding the Shift key, click on 
each marker to select all eight markers (or box them 
to select them, but be careful not to inadvertently 
select the time line).  With all markers selected, find 
the Draw pull down menu on the Drawing toolbar 
(typically at the leftmost edge).  On the Draw pull 
down menu, hover over Align or Distribute and click 
on Align Top.  All the markers should have lined up 
across their tops like good soldiers.  Next, open the 
Draw menu once more, again hover on Align or Distribute and click on Distribute 
Horizontally.  If you’ve done this correctly, the markers should be aligned with one 
another and evenly distributed along the timeline.  Now, all you need to do is hover over 
any of the markers (while all are still selected) and use the cursor keys (the arrows on 
the keyboard) to tweak them into the perfect vertical placement with respect to the 
timeline.   
 
 
If something went wrong, don’t despair; instead, hit 
CTRL-Z to undo the errant steps and start again. 
 
Adding Events 
Now, let’s use the same techniques to add labels to the markers.  Click Insert>Text Box 
and place the first label above the first marker on the far left.  If the text box is filled, 
click Fill Color on the Drawing toolbar and select “No Fill.”  Type in the appropriate date 
(7/05 in our example) and use the sizing handles on the edges of the text box along with 
the Font Size and Font Color buttons on the Formatting toolbar to set a legible label.  
Now, use CTRL-D to make labels for each marker, then align and distribute them in the 
same manner as the markers.  Finally, edit each label to reflect the appropriate date. 
 
Save and Group 
Now is a great time to save your work.  If you’re happy with the timeline, you can guard 
against accidentally messing up the alignment and 
spacing by selecting everything you’ve drawn so far 
(click CTRL-A to select everything on the slide or drag 
a box around all the timeline objects) and grouping 
them as a single unit.  To do this, right click on any of 
the selected items and click on Grouping>Group.  Now, 
you can move the timeline, along with its markers and 
labels, as one object. 
 
 
 

TIP: CTRL-Z is the “oops” 
key.  Each time you click 
it, PowerPoint backs out 
of whatever you’ve done, 
step by mistaken step. 

TIP: When you Group 
multiple objects on a slide, 
they become a single 
object that’s easier to 
move, resize and animate. 
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Add Text and Connectors 
Now, let’s add text and connectors to describe significant events and place them in 
time.  There are many effective ways to create event labels and link them to the 
timeline; but, still keeping it simple, we’ll focus on just two: text boxes and call outs.   
 
Insert a text box and size it appropriately.  If desired, choose a pleasing fill color for the 
box that contrast well with your preferred font color, then type in text describing the 
event.  Keep the labels clear and concise.  Align the center or either edge of the text 
box with the point on the timeline corresponding to the event and draw a line from the 
box to the timeline.  Don’t forget to hold down the Shift key to keep the line perfectly 
straight.  Choose the line color and style (thickness) that’s looks best to you, but seek to 
maintain some element of visual consistency with the box and text.  That is, have the 
line color match the text color or the box fill color to make it easier for a viewer to link 
the two elements back from the timeline.  Repeat this process for each event label, until 
all events are positioned on the page and linked to the timeline.  
 
Another approach to event labels is to use Call Outs, a type of 
PowerPoint Autoshape.  To add a call out, locate the Autoshapes pull 
down menu on the Drawing toolbar and select Callouts on the 
submenu.  PowerPoint will offer a choice of twenty callout styles as 
seen in the figure to the right.  Try the square cartoon speech balloon 
in the upper left corner of the menu.  Add the text of the event label to 
the speech balloon and then locate the yellow diamond at the point of 
the speech connector.  You can click and drag this yellow diamond to 
reposition the pointer.  Note that the pointer shifts to emerge from the 
side of the callout nearest the yellow diamond.  Drag the yellow diamond to the 
appropriate point on the timeline.  Now, you can select and reposition the call out text 
box and the pointer will hold its position on the timeline.  Try this using the other callout 
styles until you find the style that works best. 
 
You’ll likely find that connectors overlap labels when you’d prefer that the lines from one 
event label pass behind another event label.  PowerPoint layers objects in the order 
added to the slide.  Newer objects overlay older ones.  Fortunately, object ordering is 
adjustable by right clicking on any selected object and poising the mouse pointer over 
Order on the context menu.  Another menu will pop up, allowing you to choose to bring 
the selected object to the front of the object “stack,” shift it to the back or move it 
backward or forward, layer by layer.  It sounds a bit 
complicated, but it’s easy in practice.  Just imagine 
that every object sits on a transparent plastic layer, 
collectively like sheets of acetate laid atop a poster.  
Changing the order of a PowerPoint drawing object is 
like repositioning an acetate sheet toward the front or 
back. 
 
 

TIP: You can use the Order 
tool to move objects in front 
of or behind other objects, 
like clear plastic overlays. 
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Finishing Touches 
Once you’ve achieved proper placement of the labels and connectors with respect to 
the timeline, striving for a sequence that’s clear and logical, you can add a few bells and 
whistles to the mix.  For a professional touch, use a gradient background and fill, add 
some shadowing to the event labels and connectors, then animate the events to control 
the viewer’s focus during presentation.  
 
Gradient Background 
To add a gradient background, select Format>Background 
from the main menu.  A Background menu box will appear.  
Find the pull down color menu just below the thumbnail of 
a bar graph and click the down arrow.  Select Fill Effects 
and, on the Gradient tab, click on the “One Color” radio 
button.  For a darker background, choose a medium to 
dark hue for Color 1 (I get good results using royal blue or 
navy blue).  Then, drag the Dark-Light slider to Dark.  
Ignore the transparency settings.  Choose a Shading Style 
(the Horizontal styles work well here) and one of the four 
variants of each style.  Click OK to close the Fill Effects 
menu and Apply to close the Background menu.  
 
Gradient Fill 
To add a gradient fill to the time line bar, you must first ungroup the elements of the 
timeline if you’ve previously grouped them.  Do this by right clicking on the timeline 
group and selecting Grouping>Ungroup.  Select just the rectangle serving as the 
timeline then, using the Fill Color pull down menu on the Drawing toolbar, select Fill 
Effects.  Use the same technique just described for adding a gradient background to 
create a vertical gradient fill on the timeline.  Use a lighter gradient to denote recent 
events on the scale. 
 
Shadowing 
Adding some shadow to the connector lines and event labels gives them a 
three-dimensional character and helps them stand out, especially for those 
who have difficulty telling colors apart or when the timeline must be 
converted to grayscale for printing.  Simply select the connectors and 
boxes you want to shadow (you don’t need to ungroup them if you’re 
applying the same effect to all elements of the grouping), then click 
Shadow Style on the Drawing menu and select your preferred style (right).  
The slight drop right style (Shadow Style 14) is subtle and effective.  You 
can use the Shadow Settings menu to adjust shadow offsets, 
transparency and color. 
 
Animating your Timeline 
Adding animation to your timeline can really bring it to life.  Plus, it allows you to control 
the viewer’s focus and build your narrative gradually.  To animate a timeline built from 
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text boxes, we need to first group the event label and the connector by selecting them 
both (Shift-Left Click on each) and then right clicking to choose Grouping>Group.  Once 
grouped, each event and its connector will animate as one object.  This step isn’t 
required if you built your timeline from Autoshape Callouts because they are already a 
single object. 
 
After you’ve grouped the events, as needed, right click the first event you’d like to 
appear and select Custom Animation.  A Custom Animation will appear on the right side 
of your screen.  Click on the “Add Effect” button, then on “Entrance” in the submenu.  
Finally, select “Wipe” from the list of effects and click OK.  By default, the Wipe effect 
will have a direction of wiping in from the bottom of the slide (Direction: From Bottom).  
For event labels located below the timeline, change the direction to “From Top.”  Repeat 
this process for each event label and connector group, from earliest event to most 
recent.  Correctly completed, when viewing the presentation, you should be able to 
introduce each event to the timeline by hitting the spacebar or clicking the mouse. 
 
Spanning Slides 
If you find that there are too many events to address or the time span is so long that it 
won’t fit on a single slide, you can span the timeline across two slides and use slide 
transitions to support scrolling forward or backward in time.   
 
To accomplish this, use identical timeline bars for each slide (use Copy and Paste to 
insure consistency).  On the first slide, position the timeline segment to end precisely at 
the right slide border.  On the second slide, continue the timeline, but begin the line 

precisely at the left slide border, being careful to insure that both timeline segments 
occupy the same vertical position in both slides.  Match each slide’s background and 
timeline segment fill color to the other.  The goal is to achieve visually seamless 
transition between slides.  
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With the first slide (left timeline segment) in the editing window, 
select Slide Show>Slide Transition from the main menu.  Choose 
Push Right from the list of transitions and set the speed to Slow.  
Now, open the second slide (right timeline segment) in the editing 
window, and set the slide transition to Push Left and the transition 
speed to Slow.  If you’ve done everything correctly, you should be 
able to use the left and right cursor buttons on the keyboard to 
scroll back and forth between slide one and slide two.  If all lines 
up on the slides and the colors match, the effect should be of 
moving along the timeline in both horizontal directions. 
 
You Did It!  Now Improve It. 
There are literally thousands of ways to enhance and customize 
your timelines with PowerPoint.  Once you’ve mastered the basics, 
don’t be timid about trying something new, but avoid pointless 
flash.  Be sure the enhancement or animation you add promotes 
clarity and persuasion.  Simple is best.  
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High Tech from Day One 
 
Do you ever find yourself vowing, “Next trial, I’m going to do things differently?”  Are 
electronic discovery, paperless case management and digital presentation something 
you’re saving for “the big case” down the road?  If so, tempus fugit ergo carpe diem; or, 
as the Nike shoe folks say, “Just do it!” 
 
Let’s dispel a few misconceptions and common anxieties about going high tech in your 
trial preparation. 
 

• I need to be a rocket scientist.   Heck no!  Anyone who is reasonably 
comfortable using e-mail and surfing the ‘net has the requisite computer savvy to 
take advantage of digital trial tools and online discovery resources.  Will you do 
everything right the first time?  Probably not.  Will you be more effective this trial 
than last?  Almost certainly. 

• I’d have to buy new and expensive equipment.   To paraphrase Henry David 
Thoreau, “Beware of all enterprises that require new computers.”  Unless you are 
using six-year-old systems, chances are the hardware and software you currently 
own have enough horsepower to get you on the high tech bandwagon (and if 
your systems are long-in-the-tooth, prices for new technology have never been 
lower).  There is no better time to start than now, using what you’ve got. 

• The way I do things doesn’t lend itself to technology.  Nonsense!  If the path 
you take to higher tech trials means you’ve got to abandon what you already 
know, it’s the wrong path.  Let tech tools simplify and amplify the way you do 
things.  Start slowly.  Introduce new techniques incrementally as your comfort 
level grows, and keep at it, building on your progress. 

• Juries think high tech stuff is too slick.  You’ll only hear this from those who 
have never used tech tools.  Unless your jurors are Old Order Amish, they are 
using computers, too.  They also watch the same TV programs and movies.  
Their expectations are forged by a barrage of visually rich content from every 
medium and by trials, real and fictional, on TV and the big screen.  More 
importantly, they don’t come to court content to be bored to tears or see their 
time wasted.  If you want their attention and need their retention, engage their 
senses. 

 
The explosion of electronic evidence and growing sophistication of jurors means 
you’ve got to try.  No zealous advocate cedes the technology high ground to the 
other side without a fight.  The good news is you can do this stuff.  It’s easier than 
you think and it might be…dare I say…fun. 
 
Getting Started 
There are a hundred ways to be a more effective, organized and persuasive 
advocate using technology, but let’s start by pursuing four goals: 

 
1. Use technology to bolster and grow the visual component of your case. 
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Recommended Reading 
 
Visual Presentation 
Effective Use of Courtroom Technology: 
A Lawyer’s Guide to Pretrial and Trial, 
by D. Siemer, F. Rothschild, A. Bocchino, 
and D. Beskind (NITA 2002) 
PowerPoint® 2002 for Litigators,  
By Deanne C. Siemer and Frank D. 
Rothschild (NITA 2002) 
Persuasive Computer Presentations: The 
Essential Guide for Lawyers, 
By John H. Goodhue  and Ann E. Brenden 
(ABA 2001) 
 
Case Management and Paperless Office 
Computerized Case Management 
Systems: Choosing and Implementing the 
Right Software for You 
By Andrew Z. Adkins (ABA 2002) 
The Myth of the Paperless Office 
By Abigail J. Sellen and Richard H. R. 
Harper (MIT Press 2003) 
 
Online Resources 
Lawyer's Guide to Fact Finding on the 
Internet 
by Carole A. Levitt and Mark E. Rosch 
(ABA 2004) 
 
Electronic Discovery 
Electronic Discovery and Evidence 
 by Michael R. Arkfeld (Law Partner 
Publishing 2003) 
Electronic Evidence and Discovery: What 
Every Lawyer Should Know,  
by Michele C.S. Lange and Kristin M. 
Nimsger (ABA 2004) 
Essentials of Electronic Discovery—
Finding and Using Cyber Evidence  
by Joan E. Feldman (Glasser LegalWorks 
2003)

2. Avoid paper where it slows you down or is less effective. 
3. Access online resources to secure better intelligence. 
4. Pursue electronic discovery aggressively, tactically and with finesse. 

 
Entire books have been written about each of 
these goals (see Recommended Reading 
sidebar), but you can get going using Web 
resources alone. 
 
Visual Persuasion from Day One 
The Internet was around for years before it 
leapt into the public consciousness; but, 
hardly anyone paid attention to the ‘Net until 
it acquired a new dimension: pictures.   We 
are wired for sight and weaned on “Show and 
Tell,” not just “Tell.”  Arguments end on the 
assertion, “I saw it with my own eyes.”  Our 
ability to retain information is proven to be 
650% better when we see and hear 
information, compared to acquiring it by ear 
alone.  Visual persuasion is powerful, and 
technology makes it easy. 
 
Going High Tech from Day One for visual 
persuasion requires that you get in the habit 
of asking yourself, every step along the way, 
“How do I depict that?”  It also requires 
having a still camera at the ready—a digital 
camera is easier, but a film camera and 
scanner will do—and not being shy about 
photographing people, places and things in 
the case.  In an injury case, consider digital 
video or photographs of the scene, witness 
statements, injuries, vehicles, buildings, 
signs, debris, even bumper stickers. 
 
What you’re seeking is a visual “anchor” for 
every idea you want the jury to accept and 
retain.  These images, like hieroglyphics or 
icons on a computer’s desktop, serve as 
visual shorthand for the testimonial and 
documentary evidence.  The Web can serve 
up satellite imagery and maps to anchor 
locale.   Make it your practice to videotape 
every deposition; but, if budgetary constraints 
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make that impossible, don’t leave without snapping a few photos of the deponent.  
Using video capture devices that sell for between $50.00 to $100.00, it’s simple to 
convert analog video from VHS tapes to digital clips you can simply drag-and-drop into 
a PowerPoint presentation, edit on your PC or digitally project from your computer.  If 
you, your staff or your court reporting service synchronize video time codes to the 
deposition transcript, cross-examining a witness can be almost as simple as highlighting 
the inconsistent statement and clicking “play.” 
 
Imaging technology has never been more powerful, accessible or affordable than it is 
today. Megapixel digital still cameras have fallen far below the $200 level and afford 
direct-to-digital convenience. They’re practically giving away analog video cameras, and 
a full-page color flatbed scanner can be had for as little as $50, enabling you to 
manipulate, enhance and resize images using your computer. Even devices that allow 
you to burn your own DVDs have slipped below the $100 range. DVDs, with their 
support for content menus and hours of high-quality video, are fast becoming the 
perfect way to store and share graphics-rich PowerPoints and digital video. 
 
Trial presentation suites, like Trial Director and Sanction, are impressive tools, but you 
can perform amazing feats of power persuasion using an application you might already 
own: Microsoft’s PowerPoint.  Most users barely scratch the surface of PowerPoint’s 
capabilities and some err at the outset trying to use PowerPoint’s cheesy templates to 
structure a presentation.  But, you can benefit from PowerPoint most easily by forgetting 
any way you’ve ever seen it used and simply regarding it—at first—as a simple way to 
organize, access, present and enhance visual evidence.   
 
It’s a mistake to wait until the eve of trial to begin using a presentation program.  
Instead, flex your power persuasion muscles throughout the process—interviewing 
witnesses, working with experts and during discovery.  From Day One, begin a 
PowerPoint presentation consisting of nothing more than a white background with black 
type, or vice-versa.  Then, start inserting your visual evidence, client photos, scene 
video, maps, graphs, scans of key documents, bullet points, jury issues and the like, 
each on a single slide.  I like to scan in the covers and relevant pages of codes or 
standards my opponent violated, just to make those obligations “real” to the jury.  Don’t 
concern yourself with appearance or order at first— and certainly waste no time on bells 
and whistles like animated titling or sounds.  Just get every visual you might use into the 
presentation, resizing images for effective viewing.  All you want at this stage is a vessel 
to hold your visual anchors.  As new visuals materialize, insert them into the 
presentation…and don’t forget to periodically back up your work.  Don’t forget sound 
too.  Voice mail, recorded statements, 911 calls can all be dropped into PowerPoint, so 
engage as many senses as possible. 
 
Once your visual evidence and demonstratives are in PowerPoint, you have an easy 
mechanism to get to them.  Though most think of PowerPoint as a linear presentation 
tool, in fact, the program supports direct access to any slide (simply type the slide 
number then the Enter key) and hyperlinks from any object in any slide to any other 
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slide, file or external application.  Now, you should find yourself frequently returning to 
your PowerPoint as the case develops—to show a photo to a witness, a medical 
illustration to a doctor or perhaps a deposition video clip to the court during a motion 
hearing.  Along the way, you’ll add titles, labels, highlighting and animation, as well as 
tweaking the order of presentation, keeping what works and dropping what doesn’t.  
The PowerPoint presentation evolves with the case, and a polished presentation 
emerges gradually as your skill level grows.   
 
Rediscover PowerPoint Animation 
PowerPoint has long offered users the ability to animate text (often “enhanced” by 
grating sound effects like screeching tires), a tedious capability much to blame for the 
trepidation with which some approach PowerPoint presentations.  Use animation only 
when it serves to increase comprehension or draw attention to what’s really important.  
The animated effect that’s intriguing the first time you see it is like fingernails-on-a–
blackboard by the tenth time.  But, as banal and distracting as animation is when 
misused, it’s stunningly effective when astutely employed. 
 
The enhanced animation capabilities added to PowerPoint in versions 2002 and 2003 
might have just been an effort to afford presenters slightly less obnoxious ways to 
bounce text on, off and around the screen.   But, PowerPoint animation is capable of so 
much more.  Now, objects appearing on a slide can fade in or out, change in size or 
follow a precise path.  More importantly, multiple objects can be animated at the same 
time, with tightly controlled sequencing of appearances, movements and 
disappearances.  Plus, animation effects can be applied to the same object 
simultaneously, such layered animation allowing an object to follow a defined path while 
also, e.g., rotating and growing.  The upshot is that, with a little patient tinkering and 
creative thought, any PowerPoint user can turn out animations rivaling those once 
requiring expensive professional assistance.   You can animate complex mechanical 
processes; visually reconstruct automobile collisions and air crashes; depict needed 
safety features in operation or re-enact medical procedures.  I’ve used PowerPoint 
animation to animate things as diverse as a birds-eye view of an intersectional collision, 
a petrochemical plant explosion and the operation of a computer’s hard drive.  It was 
child’s play to bring an investigating officer’s scene drawing to life, with his little hand-
drawn cars colliding as if the police report were enchanted.  Now, adding that 
screeching tires sound effect makes a point!   
 
Experiment with animation by re-creating an intersectional collision in PowerPoint.  
Begin by drawing a rectangle to represent a car.  PowerPoint includes a toolbar of basic 
drawing tools (if you don’t see it onscreen, select View on the menu and check 
Toolbars>Drawing).  Then, right click on the rectangle and choose Custom Animation 
from the context menu.  Select Add Effect, then Add Motion Paths>Draw Custom 
Paths>Curve.  Now, click on the center of the rectangle and drag a motion path for the 
object to follow, clicking again on every point where you’d like your “car” to change 
direction.  Now, you may want to superimpose some rotation on the object to better 
mimic the real world.  Left click on the rectangle and again select Add Effect from the 
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Custom Animation menu, then Emphasis, then Spin.  You can adjust the amount, speed 
and direction of spin and, most importantly, you can instruct that the Spin animation 
event start with the motion path movement you’ve previously assigned (Start with 
Previous).  Now, you can adjust the settings to achieve fluid movement.  
 
Once you know how to animate an object, you can layer multiple effects or animate 
several objects at once or according to a time line you control.  The conceptual version 
of the wreck built with rectangles may suffice, but you can graduate to applying the 
same animation techniques to, e.g., an aerial view of a vehicle animated against a 
background of an aerial photo of the scene.   
 
Building your skill at complex, layered animation in PowerPoint will take some time and 
experimentation, but the unexpected benefit is that it’s a great deal of creative fun.  
Plus, imagine the intimidation factor when your opponent asks, “Who created those 
animations that so impressed the adjuster.” 
 
Video 
If a picture is worth a thousand words, then video must be worth 24,000 words per 
second.  It's the rare piece of video that doesn't need editing before presentation to a 
jury, and almost any video deposition is more effective when it can be distilled to a 15-
30 minute excerpt.   Once, we had to hire a video editor or manage a crude edit with 
two VCRs.  Video production was the domain of those with five-figure production 
budgets.  Now, computers, digital camcorders, video capture devices and video editing 
software have made video editing and the ability to add broadcast-quality effects and 
titling so cheap and easy.  Any lawyer in any case can produce impressive results for 
peanuts.  
 
Full-featured video editing programs like Microsoft’s Windows Movie maker can be 
downloaded for free and many excellent editing suites cost less than $100.00.  Video 
editing software breathes life into static images as well. If you scan the still photos and 
drawings in your case, you can use the pans, fades and transitions of a video-editing 
program to inject a dynamic element that works well in alternate dispute resolution and 
argument.  Adding an evocative song in the background works wonders for touching 
hearts in mediation or in final argument.   
 
Taming the Paper Tiger from Day One 
Do you seem to spend nearly as much time looking for file materials as you do using 
them?  Lawyers are experts at using technology to generate an ever-increasing volume 
of documents, but we’ve lagged behind in our use of technology to manage the 
documents we create.  Electronic mail usage far outstrips postal mail, and ninety-five 
percent of all business documents are “born” electronically.  Two-thirds of documents 
created electronically are never printed.  So, why are we still drowning in a sea of 
paper?  
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One reason lawyers haven’t gone paperless (or close to it) is that we weren’t content to 
make the leap gradually.  Digitizing an existing docket of case files is an enormous and 
costly undertaking, and requires the mastery of new tools to manage the volume.  
Instead, why not start small, in a handful of new cases, from Day One.  When the client 
comes in with paperwork, scan it from the very start.  Don’t worry about formats or 
management systems at first; just get the content into digital format.  The $149.00 
Adobe Acrobat application (not to be confused with the free Acrobat Reader software) 
scans paper directly into Adobe PDF format, and even prints your documents straight to 
PDF.  Adobe Acrobat supports free optical character recognition of smaller documents 
(e.g., fifty pages or less) but larger documents will require buying additional services or 
software.  Scan everything as it comes in.  Develop a simple, rational naming 
convention for your files, incorporating a matter name or number along with the creation 
date of the document and a unique identifier.  Beginning the file name with the date 
using the YYMMDD format is an easy way to chronologically order your documents, and 
simplifies printing index pages for the paper counterparts of your pleadings and 
discovery files.  Yes, you can still maintain a paper file in this model but, done right, 
you’ll never use it. 
 
Take advantage of the organizational features built into the operating system to add 
order to your paperless case as it grows.  It’s astounding how many users lump every 
document in their My Documents folder!  Computers users have been free of the 
tyrannical 8.3 file name structure for years, so use long file names—up to 256 
characters long in Windows XP—to be as descriptive as you’d like, and employ folders, 
views and shortcuts to best effect. 
 
As your paperless file system grows, you may want to manage it with more powerful 
tools than the operating system alone affords.  There are a host of powerful and 
inexpensive programs on the market capable of getting you to the information you seek 
at lightning speeds.  Off-the-shelf applications like AskSam or DTSearch support 
powerful search, indexing and reporting functions for under $200.00.   
 
If you aren’t already getting an ASCII disk containing the full text of every deposition in 
your cases, start doing so.  Even if your search technique consists of no more than 
opening the ASCII file in your word processor program, you’re faster than paper.  
Loading the full text of all the depositions into one of the search programs mentioned 
above is far better still. 
 
A paperless (or simply a less paper) system will save you hours of wasted time and 
offers the added benefit of extreme portability.  Thanks to recordable DVDs and 
massive hard drives, you really can take it with you.  The goal is to eliminate the bits-to-
paper-to-bits workflow.  Don’t give up paper, but confine it to output only.  Documents 
born digitally only go to paper when it makes your job easier.  If you’ve ever tried to read 
a long document on a computer screen, you know that going utterly paperless works 
better in theory than practice.  My rule of thumb is, if a document is large enough that a 
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standard staple wouldn’t work if it were on paper, it’s too long to read on-screen.  Print it 
out. 
 
Cybersleuthing from Day One 
Has the most damaging witness in your case been your own client, perhaps arising from 
a vulnerability the client didn’t reveal?  Before or right after the first appointment, use 
online resources to learn as much as you can about your client’s other claims, criminal 
record, financial status, business dealings, and discussion group participation.  Secure 
a credit record release authorization and buy the report. 
 
The Internet and for-fee information databases afford us the ability to, in minutes from 
our desks, learn more about witnesses, counsel, companies, products, jurors, judges 
and experts than we can glean from months of discovery.  Using the web, it’s a simple 
matter to track down former employees, network with lawyers in similar cases, create 
demonstrative aids, identify other claims and suits, locate assets, and even gauge 
political views based on contribution and voter registration records. 
 
Free resources like www.searchsystems.net are a gateway to thousands of revealing 
public records, and dirt-cheap databases like www.accurint.com afford lawyers 
unprecedented access to personal and financial data.  It costs nothing to set up a news 
alert at Google.com to e-mail you each time your client, opponent or whatever you 
select is mentioned in any of hundreds of news sources.  For trial lawyers, the power to 
search and review ten million pages of expert testimony at trialsmith.com seems almost 
superhuman. 
 
Data found online can be unreliable, and certainly shouldn’t be used in court or at 
deposition without verifying its accuracy, but once you develop the knack for 
cybersleuthing, you’ll find that it’s invaluable as preparation for cross-examination, 
especially for expert witnesses.  For an extensive list of cybersleuthing links and other 
resources, visit the author’s website, cybersleuthing.com. 
 
Electronic Discovery from Day One 
Ninety-five percent of all business documents are “born” digitally, and most are never 
printed.  The average business person receives over fifty e-mails daily, and few of those 
messages wind up on paper.  Records that impact our lives aren’t always discrete 
compilations, but may live fleetingly onscreen, compiled in response to database 
queries.  If your discovery focus still centers on paper, you may be missing the evidence 
that makes your case.  Winning with electronic discovery demands more than just 
adding the phrase “electronic data compilations” to your definition of document, and 
there’s no “form” set of discovery requests to shortcut the task.  Each case is different 
and requires unique strategies. 
 
Electronic data is at once fragile and tenacious.  Failing to act quickly and decisively to 
force preservation from Day One allows the digital smoking guns in your case to simply 
disappear forever.  The duty to preserve electronic evidence doesn’t hinge upon receipt 
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of a preservation letter, but a well-crafted notice specifically identifying media and 
content to be protected and detailing actions which cause spoliation of evidence makes 
inadvertent destruction less likely and raises the stakes for culpable behavior.   
 
E-discovery has enormous tactical value when aggressively pursued to impose broad 
preservation duties coupled with narrowly focused requests for production.  Forget the 
“any-and-all” requests so typical of paper discovery requests.  With computer data, it’s 
much harder for an opponent to meet a series of highly specific requests than to simply 
ignore or move to quash a scattershot demand.  Specificity is warranted for other 
reasons.  Don’t assume that your opponent understands computer systems well enough 
to appreciate where or how to find all discoverable electronic evidence without specifics.  
Plus, the narrower the request, the greater the likelihood it will be enforced and won’t 
serve as grounds for a motion to shift costs.  
 
It’s hard to win with e-discovery if you’ve no idea how and where your opponent stores 
electronic records.  Use interrogatories and Rule 30(b)(6) depositions from Day One to 
gather intelligence about the other side’s systems and procedures.  What are the back 
up procedures and rotation schedules?  Is there a document retention policy?  How is e-
mail traffic or file deletion logged?  Who works from home or using a laptop?  Enlist an 
electronic discovery consultant or former member of your opponent’s IT staff to help you 
target your inquiry, and don’t forget computer forensics.  Computers keep much of what 
people believe is deleted and closely track users’ activity without their knowledge.  On 
the right facts, a computer forensic analysis can make the case. 
 
Confer with opposing counsel, and seek the court’s assistance with e-discovery efforts 
from Day One.  A temporary restraining order may be necessary to curtail destruction of 
evidence in the ordinary course of business or secure forensically-sound duplicates of 
key players’ hard drives, thereby insuring the opportunity to access electronic evidence 
is not lost to the passage of time…or to shenanigans.  Early appointment of an e-
discovery special master helps balance the rights of the party seeking e-discovery 
against the producing party’s need to safeguard privileged, confidential or proprietary 
data. 
 
Be sure to specify the form in which the data should be produced.  If you’re set up to 
handle it, obtaining data in its native format is preferable because it permits automated 
searches and preserves revealing metadata—data about data intrinsic to every 
computer record.  Unless you prefer it, a producing party shouldn’t be permitted to 
increase your workload and costs by converting discoverable information from its native 
format—the way it’s used in the ordinary course of business—to unwieldy image 
formats or, worse, to paper printouts, stripped of metadata. 
 
Remember, electronic discovery is more than just e-mail.  Consider the wealth of 
evidence that resides in personal digital assistants, voice mail systems, cell phones and 
even automobiles.  Modern digital copiers have hard drives which store scans of copied 
documents.  Fax machines have memories, too.  Did you know that many vehicles 
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currently on the road digitally store speed and braking activity for five seconds prior to 
air bag deployment?   Imagine how that evidence might impact a disputed red light 
case.  The digital smoking gun that makes your case may soon be downloaded from 
under the dash! 
 
Just Do It 
When you were sixteen or so, you devoted yourself to learning to operate a powerful 
machine in a complex environment.  You studied.  You took lessons.  You practiced.  
Perhaps you even blundered a time or two, but ultimately you made it.  You passed the 
test, and you had your driver’s license.  The skills acquired in learning to drive a car 
serve you every day. 
 
Computers are as much a part of modern life as the automobile, yet few have devoted 
themselves to mastering their computers with the same dedication and enthusiasm as 
the automobile.  We aren’t sixteen anymore but, at any age, learning to “drive” your 
computer is a skill that will serve you every day. 
 
You don’t have to implement perfect high tech systems.  The judicious use of 
technology from Day One improves any case, not just the big or complicated ones, but 
you don’t have to use technology in every case to reap its benefits.  Each time you 
implement a new technology, it gets easier.  The greatest impediment to success isn’t 
cost or complexity.  It’s intimidation.  The longest journey starts with a single step.  Just 
do it. 
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